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Holly mee My Coursework project 1A

Power point presentation on healthy eating

Introduction

In this project 'm going to produce a power point presentation to try and convince
year 7 to eat healthier. I will use my own ideas but will also find information from
other sources, e.g. Books, Internet, food labels. I will find text information, pictures,
and number information.

Finding the information

I could find my information from the following sources.

Source what information

Internet text, pictures, and numbers
Books text and numbers

Food labels numbers

Magazines pictures and text

Clip art pictures

Collecting information not using the Internet

Clip art

I will probably use these picture because as it is for y7
because they would prefer cartoons, but it is also
important for them to take it seriously! That’s why I’ve
put in the photographs.
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I won’t use these pictures as too many photographs may
make it boring for them. I may instead insert a few more
moving clip arts to make it more fun!

A non-IT source.

I have collected food labels for my non-IT source, here is one

I will use the numbers off of this to maybe compare to a healthier option. This will
contribute to my explanation of why a healthier option is best

Info off the computer
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I found a list of foods in the cooking section on the computer; this will come in handy
when I try to explain which foods are high in witch nutrients. However some of them
are about bad foods so I may use them too to compare

Collecting information using the Internet
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This search wasn’t that successful. So I searched for two things instead.
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This search was a lot more successful! By searching with a OR or a AND you get a much
more refined search. You get more results but they are a lot more specific. These are just
some of the results
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Designing my presentation

These next three pages are my ideas for the layout of my presentation.
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I will use this layout as it contains everything I think the presentation needs, facts
about foods and charts comparing foods, eating disorders and where to get help. It is
also in a good order that is easy so the year 7 will understand it

My first draft.

Here are some of the slides from my first draft!
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By Holly Moe
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as well a5 vegetarian alternatives
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o and other soya-based
procucts,

These foods are important
sources of protein, iron and zinc,
Proteing are the building blocks of
our body which maintain healthy
tissues and repair any damage.

9 | pairy
+ Dairy products inchude milk,
yoghurt and cheese.
The most important constituent of
dairy produce is calcium, a
mineral that's essential for
healthy teeth and bones, Its
important not only for children to
have enough calcium for their
teeth and bones to grow, but also
for adults to prevent osteoporosis _|
in later life. T
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whether they're fresh, tinned, 1
frozen, cooked, juiced or dried.
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— the health baddies - fats (mainly saturated), sugar
and salt.
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however if your eating pizza and
chips every night you need to start
eating a more balanced diet!

15 (2 50 Which foods are the best for
me?
well it depends if your trying to
lose weight then a low calorieor
fat intake is best,

However if you just want to be
healthier then yau just need a
good balance of everything
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Using my survey

soft PowerPoint - [HEALTHY EATING- 29]
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dairy produce is calcium, 2
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important for children to have
enough calcium for their teeth
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10 (3 So witch food should I be

choosing?

+ Cereals, potatnes, pasta or rice
should form the basis of each
meal, with plenty of fruit and
vegetables, and smaller servings
of mest and dairy products,
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@
1% ([2) so can I still eat my favourite
foods?

¥ES, the odd McDonalds now
and then isn't gaing 1o hurt. But
however if your eating pizza and
chips every night you need t start
eating a more balanced dist!
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The information I used off
the computer I used on
this slide.

This is a screen shot of my survey witch I turned into a pie chart it is about how many

portions of fruit and vegetables 5-11 year olds eat daily
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+ OVEREATERS ANONYMOUS
(07000 784 025

+ EDA helnline on 0945 634 7650

21 [3) Treatment

+ Thie first step is talking to
SOMME0NE you can trust - this
might be a mermber of your
family, a friend or teacher, some
one you feel comfortable with.
Thig is often very hard to do -
fear of rejection, looking a foal,
not being believed - all these
concerns go through your mind.
But it is important to try and even
if you don't get the desired
response the first time, don't gi
us - help is out there for you.

E more than 5
M less than 5
O no

A

more than 3
aill|less than 5
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I then began to submit the information I found

« The first step is taking to
sOrmeone you can rust - this
might be a member of your
family, a friend or teacher, some
ane you feel comfartable with,
This iz often very hard to do -
fear of rejection, looking a fool,
not being believed - all these
concerns go through your mind,
But it is irmportant 1o try and ever
if you don't get the desired
responze the first time, don't give
us - help is out there for you.
Thenextstepcould be tosee s
GP or practice nurse,

22 [ 5 portions a day

T - ;

|| — . =
il Default Design [ax

B course wark - 28 sepk - .. rosoft Powet]




Holly Mee 11 02/05/2007

l]:l = [ Plot Area

« The first step is talking to
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might: be a member of your
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one you feel comfortable with,
This is often very hard to do -
fear of rejection, looking a fool,
not being believed - all these
concerns go through your mind.
But it is impartant to try and even
if you don't get the desired
response the first time, don't give
us - help is out there for you, Emore than 3
The next step could be msee a B less than 3
GP or practice nurse. Ono

2z [@ 5 portions a day

—JIClick to add niotes

[ ple eae wew tnser: Far o
DA @k@‘g} & ; ! mes New Roman

helps adults osteoporosis in later 24
life.

10 (3 So witch food should I be
choosing?

+ Cereals, potatoes, pasta or rice
should form the basis of each
meal, with plenty of fruit and
vegetsbles, and smaller servings
of meat and dairy products
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14 3 50 can I still eat my favourite
foods?
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Using information from the Internet
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For the picture on this slide (mc Donald’s chicken nuggets) I had to find the mc
Donald’s website.
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First I searched on ask Jeeves and these are the results it came up with
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Macdonalds
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McDonald's
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From: www.mcdonalds.nl/ Checkers Fast
Food

Mcdonalds UK

McDonalds in the UK. Medonalds Toy

From: wwww . mcdonalds.co.uk/ Collect

McDonald's

Arcos Dorados S. 4. - Todos los derechos reservados - 2002 | Politica de

Privacidad... Obsolete Ford

From:wyww . mcdonalds . .com.ar/ Parts
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I then thought the Mc Donald’s Uk one would be good so I entered the site.
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I wanted a picture of their food so I found the menu bar and clicked on our food. It
then came up with a selection of different menus so I clicked on favourites.
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then I selected nuggets, and copied the picture
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I then had to crop the picture because I didn’t want the writing, I did this using paint.
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I know this isn’t healthy food but I used when saying that fatty foods are ok in
moderation.
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I wanted to have an unhealthy picture on my first slide but also wanted to make sure
the y7s new that the item of food was bad so I went to my slide and went into clipart.
I found a picture of a bag of chips.
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I inserted in on to my slide and copied and pasted it into clipart where I drew to big
black lines through it to indicate that the food was unhealthy.

i untitled - Paint 13| x|

Edit View Image Colors Help

[For Help, dlick Help Topizs on the Help Menu, e f134am
iflistart| [Eln Paint - [H...| ] k12 2-10 - M. |[Fjuntitled - Paint I 2w

I then copied and pasted it back on to my slide.
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1 5 HEALTHY EATING

By roly Meg
23 why Should we eat Healthy?

« Eating healthy Is proven to
reduce the change of cancer,
heart problems, asthma and
other diseases.

« If your diet doesn't include S
portions of fruit or vegetables 2
day you are more likely to
become obese (averweight)

« And by eating 5 portions of fruit
and yeq a day you will feel 3 iot
more energetic and generally
better!

33 Did you know?

+ By eating broccoli, Brussels
sprouts, tabbage, caulifiower,
can reduce your chance of
getting cancer by up to 40%

« Walnuts can thin your blood and
witch helps prevent clots!

+ Strawberries can reduce stress ﬁ lick tor add notes

On ‘the basics’ and the eating disorders I wanted to be able to go to any slide so I
inserted hyperlinks

[&] Microsoft PowerPaint - [HEALTHY EATING- 9-10]
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healthier then you just need a good-
balance of everything :
16 2 Low and high fat foods R ; R /
17 [E Eating Disorders - -
18 [0 Anorexia nervosa
18 3 Bulimia Nervosa

20 [0 Binge Eating

21 [J) where to get help!
[« Friends
Friends can be of great suppart

in helping peaple cope with this
illiess. EDA's experiences shows
hat suppart from friends and
farmily can really el people to
vecover even when they are
receiving professioral help and
atbvice,

Your GB

Seenaa GP
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.| |Click t0 add notes

Howeer f you Just want to be
healthier then you just need a good
balance of everyting

16 32 Low and high fat foods

17 [@ Eating Disorders

18 2 Anorexia nervosa

18 (3 Bulimia Nervosa

202 Binge Eating

21 (2 where to get help!

+ Eriends

Friends can be of great support
in helping pecple cape with this
illness, EDA's experience shows
that support from friends and
family can really help people to
recover even when ey are
receiving professional help and
advice.
Your 6P |
Seeing & GP can be @ anod start, It

I then selected hyperlink
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I then selected slide titles and then selected binge eating.
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2 [Z) why Should we eat Healthy?

+ Eating healthy is pryen to reduce
the change of cancer, heart
problems, asthma and other
diseases

+ If your diet doesn't include S
portions of fruit or vegetables a
day you are mare likely to
become obese (overweight)

+ And by eating 5 portions of fruit
and yea a day you will fesl & lot
mare energetic and generally
better!

33 pid you know?

[« By eating broceali, Brussels
sprouts, cabbage, cauliflower,
can reduce your chanwe of
getting cancer by up to 40%

« Walnuts can thin your blood and

witch helps prevent clots!
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On this slide I may shift the
picture down are insert
another one, as the space
under it looks pretty empty.
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+ ED& help line on 0845 634 7650

Treatment

2 [0 Treatment » The first steg is talking to someone you
h can trust - this might be a member of
your family, a friend or teacher, some
one you feel comfotable with. This is
often very hard to do - fear of re
looking a fool, not being believe
these concerns go through your m
But it is impartant to try and even if
you don't get the desired response the
first time, don't give us - help is out
there for you. The next step could be to
see a GP or practice nurse.

On some slide I have
made spelling mistakes, I
will have to correct these
using spell checker or a
dictionary
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that would you like to do?
v do you change the colour of the
text on hyperlinks

‘Select topic to display:

N
Changs text color
(Changs the way text looks

change a color-scheme
color

Custom tal

Custom tab to mix your own

dlick OK.

brightness, and then cl

standard Scheme

current slide, click Apply.
To apply it to all slides in the

Additianal resourcs

. On the Format menu, dick Slide
Color Scheme, and then click the

. Under Scheme colors, ciick the
color of the feature you want to
change, and then dick Change
Color.

. Click the Standard tab to select
from the calor palette, or click the

. In the Standard color paletts,
click the color you want, and then

In the Custom color palette, drag
the cross-hair o select a colar,
drag the scroll bar to adjust the

. To save your color scheme with
the presentation, click Add as

+ To apply the new color to only the

presentation, click Apply to All

m I
i#Rstart | &) Coursemork ta 2010 .. |

irasoit PowerPoint - (.| [ Microsoft PowerPoint ..

10:22
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I didn’t know how to change
the colour on hyperlink text
so I had to go to Microsoft
power point help.

I couldn’t find what I wanted on
the menu, so I went to answer
wizard.

I typed in my question and it
came up with three different
answers. I clicked on
hyperlink colour because I
thought that would be most
useful.
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change a color-scheme color

. 0n the Format menu, dick Slide
preventciots! Color Scheme, and then click the

It then came up with the answer.

2. Under Scheme colars, click the
calor of the feature you want &
+ Bananas are pre. change, and then click Change
calm a bad coug.
+ By eating 5 or n_ 5. Clck the Standard tab o select
rom the color palette, or click the
apples 3 weeky palette,
sl v oot s i o | Custom tab to mix your own oolor,
arelikely o be 4. Inthe Standard color polette,
4@ THE BASICS : slick the salor you wart, and then
5 3 Fruits and vegeta | i . i y "
e Al In the Custom color palette, drag
ereals and g the cross-hair to select 3 color,
7@ Fats and sugars drag the scroll bar to adjust the
brightness, and then dlick 0K,
5. To save your color scheme with the
presentation, dlick Add as
Standard Scheme
6. Toapply the new color to anly the

current slide, dlick Apply

To spply it to all slidss in the
presentation, dlick Apply to All.

Additional resources

Microsoft PowerPoint Help. =TES)
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« Walnuts can thi Change a color-scheme color
blooc and withg on the Format menu, ciick Slide

pr:vgnt(\um.‘ Line ; ' color scheme, ond the cick the I Started tO fOHOW the

| Under Scheme colors, click the . .
B e calar of the feature you want to tru t
s o e || Bt instructions.

calm a bad coug

«ByeatingSorm 3. Click the Standard tab to select
from the color palette, or dlick the
Custom tab to mix your own color,
4. Inthe Standard color palstte,

4 @) THE BASICS :Bo. ek Yo ool o s
. dlick OK.

5O Fruits and vegeta |
¢ D) cereals and grai the cross-hair to sslect & color,

7 © Fats and sugars drag the seroll bar to adjust the
brightness, and then dlick 0K,

In the Custom colar palette, drag

To save your color scheme with the
presentation, click Add as
Standard Scheme.

To apply the new color to only the
current slide, dlick Apply

To spply it to all slidss in the
presentation, dlick Apply to All.

Additional reseurces
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+ Walnuts can thin your blood and =
witch helps prevent clots! .
« Strawberries can reduce stress
and calm anisty. ;
« Bananas are proven to calm a
bad cought
+ By eating 5 or more pples a
week your Ling functions and
asthma are liksly to be better .
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containing fats and sugars suich
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Foods n thie group are
concentrated sources of
calories, s no good if you're
watching your weight, and
sweets and snacks are packed
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It is now a lot easier to read.
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could tak 1o the practice nurge o
someone at school or college that
you trust,

+ OVEREATERS ANONYMOUS
07000 784 985
+ EDA help line on 0845 534 765

2z @ Treatment

+ The first step is taking to
30MNE0NE you Can trust - this
might be a member of your
family, a friend or teacher,
some one you feel comfahle
with, This is often very hard o
do - fear of ejetion, Iooking a
fool, not being believed - all
these concerns go through your
mind, BUE it is important 1o try
and even if you don't get the
desired response the first time
don't give s - help is out there
for you, The next step could be
tnsee a GP or practice nurse.

ick to add notes

On some slides I have to change some spelling mistakes I will do this using ABC
spelling and grammar.

ID ﬁ:ﬂ Z|& %J ?’.\’J:Q - || Times New Roman  ~ 44

1 D HEALTHY EATING

Sy Fiolly Mee
2 @& why Should we eat Healthy?
« Eating healthy is pryen to reduce
the change of cancer, heart
problems, asthma and other
diseases

+ Ifyour diet doesr't inchude 5
portions of fuit or vegetables a
day you are maore lkely t
become obese (overweight)

« and by eating S portions of fruit
and veg a day you will feel a lot
more energetic and generally
better!

3 2 pid you know?
+ By eating broccali, Brussels
sprouts, cabbage, cauliflower,
can reduce your charve of
getting cancer by up to 40%

+ Walnuts can thin your blood and
witch helps prevent ciots!

« Strawberries can reduce stress

I first found the spelling I wanted to correct.

Then highlighted it, then I went to the tools menu and picked spelling and grammar.
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By Holly tee
2 (@ why Should we eat Heal
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« If your diet doesr't inch._
portions of fruit or vegeTSHTEs 3
day you are more likely to
become ohess (averveight)

+ A by eating 5 portions of fruit
and veg & day you will feel a lot
more energetic and generally
better!

3 2 Did you know?
« By eating broceoli, Brusssls
sprouts, cabbage, caulifiower,
can reduce your chanve of
getting cancer by up to 40%
« Walnuits can thin your blood and
witch helps prevent clots!
~ Strawberries can reduce stress
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portions of fruit or vegetables a
day you are mare likely o
become obese (overweight)

+ &nd by eating 5 portions of fruit
and yeg a day you will feel a ot
more energetic and generally
better!

33 pid you know?
[T« By eating broccoli, Brussels
sprouts, cabbage, cauliflower,
can reduce your chanve of
getting cancer by Lp 1D 40%

« Walnuts can thin your blood and
wiitch helps prevent clots!

« Strawberries can reduce stress

1 D HEALTHY EATING

Sy Fiolly Mee
2 @& why Should we eat Healthy?
« Eating healthy is pryen to reduce
the change of cancer, heart -
problems, asthma and other
diseases

+ Ifyour diet doesr't inchude 5
portions of fruit or vegetables a
day you are maore lkely t
become obese (overweight)

« and by eating S portions of fruit
and yeg a day you will feel a ot
more energetic and generally
better!

3 2 pid you know?

+ By eating broccali, Brussels
sprouts, cabbage, cauliflower,
can reduce your chanve of
getting cancer by up to 40%

+ Walnuts can thin your blood and
witch helps prevent ciots!

[2] + Strawberries can reduce stress
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1 5 HEALTHY EATING

By roly Meg
2 (B why Should we eat Healthy?

« Eating healthy Is proven to
reduce the change of cancer,
heart problems, asthma and
other diseases.

« If your diet doesn't include S
portions of fruit or vegetables 2
day you are more likely to
become obese (averweight)

« And by eating 5 portions of fruit
and yeq a day you will feel 3 iot
more energetic and generally
better!

33 Did you know?
+ By eating broccoli, Brussels

sprouts, cabbage, caulifiower,
can reduce your chanve of
getting cancer by up t 40%

« Walnuts can thin your blood and

witch helps prevent clots!

[E microsoft PowerP - [HEALTHY EATING- 29]
IE ot Teols Sk shon
DBHS & B o i

+ OVEREATERS ANONYMOUS
07000 784 985

« EDA help line on 0845 634 7650

22 (@ Treatment
« The first step s taking o

s0mEons you can frust - this
might be & member of your
family, a friend or teacher, some
ore you feel comfortable with
This Is often very hard to do -
fear of rejection, looking a fool,
not being believed - all these
concerns go through your mind,
But it is important to try and
eien if you don't get the desired
respanse the first time, don't
give us - help is out there for
you. The next step could be to
see 3 GP or practice nurse.

23 ) Summery
- S0 the impartant thing to
remember are:

« Drink & glasses of water 38y { [y 1o acd notes
L o nf 1

This slide was to empty, I have decided to put a picture, but because it’s a bit of a
delicate subject I don’t want to put a funny picture in. therefore I have decided to use
a phone.

First I had to get up the clip art file I did this by going to the insert menu. Then picture
then selected clip art.
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I got the clip art window up
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I then typed ‘phone’ into the search box and hit the ‘go’ button
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It came up with lots of different pictures but none I liked.
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so then I went to motion clips instead
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Keep Looking

-

I quite liked the picture at the end, but I had to see what it did so I clicked the left
button on my mouse when the cursor was over the picture.
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Then clicked on play clip.
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I liked it so I inserted it on to my slide
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My final draft
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Where I can I’ve have made the text the same size and font for easier reading, I have
also tried to make my work consistent by putting all the pictures on the same side and
making all my writing the same font and my titles the same size.
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2 [Z) why Should we eat Healthy?

+ Eating healthy is proven to
reduce the change of cancer,
heart problems, asthma and
other diseases,

+ If your diet doesn't include S
portions of fruit or vegetables a
day you are rmare likely to
become obese (overweight)

» And by eating 5 portions of fruit
and yen a day you will feel 5 lot
rmare energetic and generally
better!

32 Did you know?

» By eating broccoli, Brussels
sprouts, cabbage, cauliflower,
can reduce your chance of
getting cancer by up to 40%

« Walnuts can thin your blood and
which helps prevent clots!
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I have tried to make every slide as interesting as possible so the year 7°s do not lose
interest. I have done this by adding pictures, both still and moving.
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I have corrected all spellings as best I can but I will need an adult to double check to
make sure.

How I saved my work

&My Documents

File Edit View Tools Help
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Address 3 My Documents
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Windows
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First I arranged all my work it to different groups, and created folders for these.
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Then I sorted all the Gese work it to different pieces of course work and work for the
other ICT lesson I do.

& slide show
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I found it a little confusing because I had so many pieces of work. So I put all the
work in the different months folders depending when they were made.
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Ten all the different pieces of work are dated so I can see what I did last!

My wider knowledge of ICT

The advantages of ICT are that when making a piece of work you can easily change a
mistake or error where as in a hand written piece you would have to start again, also
you can add images, sounds moving pictures very easily. The disadvantages are you
can take a piece of paper anywhere and write on it but a computer isn’t portable
(unless it’s a lap top), also the spell checker is not always right so you could end up
with the spelling ‘Witch’ instead of ‘Which’ but the computer would not notice.

Copyright

Copyright protects any original thing a person has done from a work of art to an
invention. Copyright protects anyone else from passing off as his or her work or idea.
If you use a picture or a piece of writing a piece and try and pass it off as your own
you are breaking the copyright act. As long as you have that persons permission to use
their work or acknowledge it is theirs somewhere on the work then you are not
breaking the copyright law!

Viruses
Viruses can be caught in many ways, these are just a few

e Putting an infected floppy disk into your computer - the virus can automatically
copy itself from the infected disk into your computer

e Downloading infected files from the Internet

¢ Obtaining software from an unreliable source

There is usually no evidence of the virus and the user is not usually aware of the virus -
until something goes wrong.

Different viruses cause different problems some can delete your files, corrupted your
data or crash your memory.

These are some of the ways viruses can be prevented in many ways,
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Using virus checking software

Not allowing other users to use their own floppy disks on your system

Not allowing users to take the company's disks home to use on their own PC
Only downloading files from reputable Internet sites

Write-protecting disks

Avoiding software from unreliable sources

Backing up data regularly

Shutting down your computer

When shutting down your computer you have to turn it off from the start menu you
can’t just shut it off at the mains.

First make sure all your work is saved
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then go to the start menu

£ 314 Floppy ()

My Computer
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Then shut down
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Ends your session and shuts down Windows so that

oK I Cancel

Make sure shut down is selected. Then when it has completed shutting down then you
can turn it off at the mains!

In my project

For my slide show I have used many things that just wouldn’t be possible on paper. I
have used hyperlinks, images, and moving images; I could have used sounds and
music as well. Also because it’s on a computer I can easily present it to the year 7°s
and they will all be able to see it but if it were on paper I would have to make a
separate copy for each of them, which wastes time and money.
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Safety in the computer room

Here are just some of the safety problems that can occur while working at a computer
and how to solve them

Problems Solutions

Back problems- due to poor A fully adjustable chair, screens should be

posture or an awkward position. tilted and turned to avoid bad or awkward
movements.

Repetitive Strain injury (RSL)- Make sure posture is correct; use wrist rests

damage to fingers, wrists and other | and have a five-minute break from typing
parts of the body due to repeated every hour.
movement over a period of time.

Eye strain- strained after staring at | Screen filters can remove a high percentage
a computer screen for a long time | of the harmful rays emitted from a
particularly in bad light or a computer screen. Use non-flickering
flickering screen. screens. Take regular breaks, and make sure
lighting is suitable.

Ozone irritation- laser printers are | Place laser printers at least one meter away
thought to emit Ozone that can from where people are working and there
lead to breathing problems should be good air ventilation
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Employer regulations

General working environment

Employers must:

e Provide tilt able screens
Provide anti-glare screen filters
Provide adjustable chairs
Provide foot supports
Make sure lighting is suitable
Make sure work stations are not
cramped

e Plan work at a computer so there

are breaks
Pay for eye and eyesight tests by an
qualified optician

There should be no trailing wires
Food and drink should not be placed
near a machine

Electrical sockets should not be
overloaded

There must be adequate space around
the machine

Heating and ventilation must be
suitable

Lighting must be suitable with no glare
or reflections

Benches must be strong enough to support
computers




